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Safety Precautions

Before using your scanner, read the following safety guides carefully, which
detail the proper operation of the scanner and its accessories to prevent injuries
or damage to users or equipment.

Meanings of Symbol Signs

=>[>

This indicates hazardous situation which, if not paid
CAUTION attention, could result injury or damage to users or
equipment.

This indicates hazardous situation which, if not paid
WARNING attention, could result serious injury or death to users.

Power Supply:

A

AN A
AN/

ANA T

Use a power source only with a power rating specified on the marking label.

Ensure to turn off the power of each device before connecting or
disconnecting the cables.

Insert the plug completely into the outlet, as a loose connection may cause
arcing and result in fire.

Ensure to hold the plug or connector to disconnect the cable; otherwise, if
you pull the cable only, it may damage the core wire and result in fire or
electric shock.

Place and route the power supply cord such that it is not likely to be walked
on or pinched by items placed upon or against them, paying particular
attention to the cord near the power plugs, convenience receptacles, and at
the point where it exits from the outlet.

When the scanner is left unattended and unused for long periods of time,
unplug it from the wall outlet.

Moving and Storing the Scanner:

A

AA T

ANAN

Always ensure that the scanner is stored properly before shipping or
moving it. Quick stops, excessive force, and uneven surfaces may cause
the product to overturn when moving.

Do not hit or drop the scanner. The scanner may be damaged if it receives
a strong jolt, which may result in fire or electric shock if the scanner is used
without being repaired.

Do not place the scanner on any slippery, slanted, or unstable surface. The
product may slide or fall, causing serious injury to people as well as serious
damage to the product.
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A A e Do not use the scanner near water. Never spill liquid of any kinds on the
product, or it may result in electric shock or other hazards.

A A e This scanner should be situated away from heat sources such as radiators,
heat registers, stoves, or other products (including amplifiers) that produce
heat.

& e Do not store the scanner in which it may be exposed to direct sunlight.

A & e Do not place the scanner near the edge of a table. When the drawer of the
scanner is opened, the weight of the product may cause the scanner falling,
causing serious injury to people as well as serious damage to the product.

Using the Scanner:

A e  The maximum loading weight for upper and lower scan beds is 5.5 Ibs (2.5
kg). Do not put any material on scan beds heavier than the loading limit.

Maintenance and Service:

& e When the scanner is going to be cleaned, ensure to turn off the power of
each device and unplug the power cable from the AC outlet.

& e When you need a repair service, unplug the scanner from the power outlet
and consult qualified service personnel.

A e When replacement parts are required, use replacement parts that are
specified by the manufacturer or have the same characteristics as the
original parts.
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Knowing about Your Scanner

The ObjectScan 1600 is a professional scanner exclusively designed for
transferring originals of samples into digital formats. It is ideal for capturing
images for small and stereoscopic objects and these images can be used in
many categories, such as collections, teaching, researching, manufacturing and
web business. At the same time, the ObjectScan 1600 is also able to scan paper
materials, for example, prints and researching papers.

Features of the ObjectScan 1600

The ObjectScan 1600 comes with several important features, including the
following:

Non-contact scan (on-top scan) Design — The ObjectScan 1600 takes on a
design of a non-contact scan (on-top scan) structure. Under this structure,
users have no needs to spin sample face down on the scan bed, and enjoy
the scan work without worrying about the problems that traditional flatbed
scanners deal with, such as damage problem caused by directly contact
each other.The ObjectScan 1600 is perfect for digitalizing the originals of
samples.

Energy-saving tri-wave LED light source — Adopting tri-wave LEDs as the
light source, when the scanner is detected by the system, there are no
requirements for any warm-up time before carrying out the scan, which
boots your productivity and reduces energy costs amazingly. With its stable
performance, the image quality will remain consistent even after used for a
certain period of time.

Color CCD with 1600-dpi high resolution — The ObjectScan 1600 has a color
linear CCD with resolution that reaches up to 1,600 pixels per inch.Thus, it
can clearly capture images for shapes and textures of objects, presenting
original appearances of objects precisely and decreasing the happenings of
damages on objects when doing researches.

Microtek ScanWizard LS (USB) software — ScanWizard LS (USB) is
software exclusively designed for scanning and saving objects' graphs. The
friendly user interface of ScanWizard LS (USB) provides users an easy and
quick access to initiate.

System Requirements

DVD-ROM/CD-ROM drive (for installing software)
Color display with 24-bit color output capability
4 GB memory or above

Intel Core i5 Processor at 3.0 GHz or above

Microsoft Windows 7 or Windows 8
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Taking a Closer Look

Front View

No. Names of Parts

Functions of Parts

1 Indicators
(Green and Orange)

Displays the status of the scanner.

2 Drawer of the Scanner

Carries the upper scan bed and the lower scan bed of the scanner.

3 Handle of the Drawer

Holds to open or close the drawer of the scanner.

4 Right Handle

Holds to move the scanner.
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Back View

No. Names of Parts Functions of Parts

1 Power Connector Connects the scanner to the power cord.

2 Hi-Speed USB Port Connects the Hi-Speed USB (USB 2.0) cable to the computer.
3 Power Button Turns the scanner on or off.

4 Left Handle Holds to move the scanner.

ObjectScan 1600 User's Manual

9




Initiate Setup

Step 1: Unpacking Package Contents

After unpacking your scanner package, please check for the major components
listed below.

- e

Upper scan bed

Scanner

Power cord Software CD/DVD Hi-Speed USB cable
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Step 2: Installing the Software

Important: You must install all software before connecting your scanner.
Always close any open programs and turn off Anti-virus utilities before installing
software.

1. Turn on your computer.

2. Place the Microtek Software CD/DVD
into a drive.

3. Follow the on-screen instructions to
install the driver and software.

Note: If the Microtek Software
Installer screen does not come

up automatically, double-click

the following in succession: “My
Computer”; the CD/DVD-ROM icon;
then Setup.exe to start the installer
program.

4. Click EXIT on the Microtek Software Installer screen when all the software
has been installed.

5. Restart your computer.

Note: If the system displays a message “Found a new hardware” after the
computer is restarted, please select the installer program automatically.
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Step 3: Unlocking the Scanner

1. Locate the locking screw at the middle of the right panel of the scanner.

2. Using a flat-head screwdriver, pass through a round circle at the outer shell
of the scanner and insert a hollow side of the locking screw: a) push to the
end with force, and b) turn the locking screw counterclockwise 90 degrees
to the unlock position.

When successfully unlocked, the screw will push out a little, protruding
slightly from the front of the scanner. Also, the pattern of the hollow side of
the locking screw will be turned horizontally.

= (D

Unlocked Locked

b) Turn counterclockwise

a) Push to the end with force

Note: If you have to transport the scanner, you will need to lock the scanner
back. Follow the steps below:

1. Turn off the scanner if your scanner is on. Make sure that the power button
light (green power light) is off.

2. Turn the scanner back on. Make sure that the Hi-Speed USB cable has
connected computer with your scanner properly. Then, activate ScanWizard
LS (USB) software program. Make sure that the control panel of the
software has been displayed on the screen successfully.

3. Using a flat-head screwdriver, pass through a round circle at the outer shell
of the scanner and insert a hollow side of the locking screw. Push down
with force and turn the locking screw rclockwise 90 degrees to the lock
position.

4. Shut down ScanWizard LS (USB) software program and turn off your
scanner. Hereby, the scanner is ready for transport.

12 ObjectScan 1600 User's Manual



Step 4: Installing the Upper Scan Bed

For the safety of the package delivering, the upper scan bed is packed seperately
from the scanner unit. Before using it with the scanner, follow the steps below
to assemble it in the scanner:

1. Locate a handle at the front
panel of the scanner. Grab it
to pull out the drawer of the
scanner until reaching the
edge of end.

2. Locate two hollows at the left
side of the lower scan bed.

Hollows

3. Insert the stools at bottom of
the upper scan bed into the
hollows on the lower scan
bed. Make sure the upper
scan bed has been assembled
in the scanner firmly.
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Step 5: Connecting the Scanner

To the Power Source
1.  Connect one end of the power cord to the back side of the scanner.

2. Plug the other end of the power cord into a power source.

To the Hi-Speed USB Cable
1. Connect one end of the Hi-Speed USB cable to your computer.
2. Connect the other end of the Hi-Speed USB cable to the scanner.

3. Switch the Power button at the back side of the scanner to ON, and wait for
the indicators light on the front panel to stop blinking and stay on steady.

The system will detect your scanner automatically.

v/

ON OFF
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Scanning the Materials

Positioning the Materials

1. Locate a handle at the front panel of the scanner. Grab it to pull out the
drawer of the scanner until reaching the edge of end.

2. If the height of a scanned object is less than 2.76" (7 cm), center the object
to be scanned facing up directly on the upper scan bed.

When placing the scanned object, do not block the calibration area.

Upper scan bed

Calibration area is next to the upper
scan bed.

ObjectScan 1600 User's Manual 15



3. Ifthe height of a scanned object is larger than 2.76" (7 cm) (the maximum
height is 5.9" (15 cm)), take out the upper scan bed from the drawer; then,
Center the object to be scanned facing up on the lower scan bed of the
drawer.

When placing the scanned object, do not block the calibration area.

independent and unremovable
entity which is located at the right
side of the drawer.

4. When done, grab the handle of the drawer and push it back into the
scanner. When "click" sound is heard, the drawer has been closed

properly.

Note: The maximum loading weight for scan beds is 5.5 Ibs (2.5 kg). Do not
load any material heavier than the loading limit.
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Using ScanWizard LS (USB) Software

ScanWizard LS (USB) is scanning software exclusively designed by Microtek for
scanning large-size materials. Its user-friendly interface enables the beginners
or the professionals to start the scanning process easily and quickly. Refer to
the section “Knowing about ScanWizard LS (USB) Further” in back for more
details.

1. Refer to the descriptions in “Positioning the Materials” to place the material
to be scanned on the scan bed.

2. Launch ScanWizard LS (USB) and the main control panel will appear on the
screen.

3. Click the Preview button in the control panel to perform a preliminary view
of the entire image. When done, a preview image appears in the preview
window.

Note: If you want to cancel the action of the Preview command, press the
Esc button on the keyboard.

4. If necessary, click the Scan Frame tool button to adjust the size of the scan
frame, enclosed within the red dotted lines. Drag on the edge or corner of
the scan frame to resize the scan frame.

5. Click the Window menu and then select the Tools option. The Tools window
will appear on the screen immediately. Specify your scanning requirements
in theTools window.

Open theTools [
Window and Files — Scanner Window About

AdvancedTools B[ Proview Window
Window from the a ﬁ
Window menu Advanced Tools » St

a) Select your desired image output Resolutions
resolution in the Resolutions drop-down 200 dpi
menu. b 1 dpi

b) Select your image output type in the
Color Modes drop-down menu.

6. If necessary, adjust image quality by using the 1500 dpi
image correction tools. To activate the image
correction tools, click the Window menu
and then select the Advanced Tools option.

Specify your scanning requirements in the Color (24 bits) w

AdvancedTools window. Crav (B bits
Color (24 hits)
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7. Click the Scan button to start scanning.

The material will be scanned and delivered to the directory where you
specify.

Note: If you want to cancel the action of the Scan command, press the Esc
button on the keyboard.

Files Scanner Window About

Resolutions
300 DF1 -

Color Modes

Color (24 bits) -

® ©

Select Scan Range

N x|

JMICROTEK

Level Adjustments

Gamma

Black Levels
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Understanding ScanWizard LS (USB) Further

From the previous section, you have gotten a general picture about how to
use your ObjectScan 1600 together with ScanWizard LS (USB) software. At
this chapter, you should be able to get to know commands and functions of
ScanWizard LS (USB) software further and better; then, you would be able to
manipulate it more conveniently.

Launching ScanWizard LS (USB)

&l To launch ScanWizard LS (USB), double click the ScanWizard LS (USB) icon on
the desktop. After being launched, the main control panel will appear on the
screen.

Exiting ScanWizard LS (USB)

To exit ScanWizard LS (USB), click on the close box on the top-right corner of
the control panel.

Files Scanner Window Abount
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Familiarizing with the Main Control Panel of
ScanWizard LS (USB)

There are major commands, tools and function buttons in the main control
panel of ScanWizard LS (USB) which control and dominate your scanner.

Elements on the Main Control Panel

Files  Scanner Window About

& & 9 6

Menu bar: Includes Files, Scanner, Window and About menus.
Select Frame button: Used to select and adjust the area to be scanned.

Magnify button: Clicks to zoom in (magnify) partial area of a scanned image.

o o = »

Rotate Counterclockwise button: Clicks to rotate an image in the Preview
window counterclockwise.
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Rotate Clockwise button: Clicks to rotate an image in the Preview window
clockwise.

Preview button: Clicks to generate a preliminary scanned image.

Scan to Save button: Clicks to perform the final scan of the original and save
the scanned image to your chosen folder.

Minimize button: Clicks to minimize ScanWizard LS (USB).
Close button: Clicks to exit ScanWizard LS (USB) software.

Preview area:This area in the Preview window shows the preview image.
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@ Select Frame Button

The Select Frame button lets you select and adjust the area to be scanned in
final.

To draw a frame, click the Select Frame button; then, move the pointer directly
to the scanned image and draw a frame enclosing the area to be selected.

To cancel a drawn frame, click the right button of the mouse and then the frame
will be removed immediately from the screen.

| W ] | v ]

MICROTER MICROTER

Scanning without a frame Scanning with a frame

@ Magnify Button

The Magnify button lets you magnify (zoom
in) the partial area of a scanned image to
inspect the quality for after-scan image.

To magnify, click the Magnify button, move
the pointer to the area of a scanned image
where you want to examine, and then

click. The pointed area will be enlarged
immediately on the screen.To magnify other
area, just move your mouse there and click
the left button of the mouse.

To cancel using of a magnify, just click the
Magnify button again.

22
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Rotate Counterclockwise/Clockwise Buttons

The Rotate Counterclockwise/Clockwise buttons let you rotate a preview image
counterclockwise or clockwise in 90 degrees. When the image in the Preview

@ area (Preview window) is rotated, the ruler at top will be turned in the same
direction at the same time, which is helpful for you to check the real position of
the scanned image on the scan bed.

=] Preview Button

— The Preview button scans an image based on the settings on the ScanWizard LS
(USB) control panel, and displays the preview image on the Preview window.

To cancel a preview action, please click the Esc button on the keyboard.

MICROTER

Preview area

Scan to Save Button

< The Scan to Save button scans the images from your scanner and delivers the
images to your selected folder.

When the button is clicked, the “Save As..” dialog box appears. Take turns to
key in a file name, a saved folder direction and an export file format.

If you want to cancel a scanning job, please click the Esc button on the
keyboard.

1. Saved folder direction: To select a folder for your scanned and saved
images, either use a folder selected by default or click the Arrow button
next to the column to explore, search and select folders you want to use for
saving scanned images.
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2. File name:This column lets you to key in a desired file name.

If Auto File Name is enabled, the name entered in the File Name column will
become the file prefix, and a serial number added up automatically by the
system will be attached afterward.

3. File format: This menu box lets you select a file format when saving a file.
The supported format includes JPEG, BMP, TIFF, and PDF.

If “JPEG” is selected as your file format, you are allowed to adjust qualities
by dragging a left-right bar appearing below.

When all settings are done, click the Save button. The Save As... dialog box will
be closed and ScanWizard LS (USB) will start to perform the final file scanning
and saving.

C-\Program Files (£86)\Microtek\ScanWizard LS ( = <} 0

IPEG (*.ipe) 7 ©

JPEG Setting
|- Quality

Worst il=23

Auto File Name

i me LEEES
File Serial LU
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The Files Menu

Load Scanning Settings

Save Scanning Settings
Restore the Defaunlt Settings

The Files Menu lets you:

e  Save the current scanning settings as a template and load it at a later time
when you work on the same kind of the images

e Load the settings saved earlier and apply them to the current scan job

e Restore scanning settings back to the default settings

Save Scanning Settings

This command lets you save current scanning settings, such as resolutions,
color modes, saturation and brightness, as a template when performing a
scan job. The saved template can be loaded at a later time when scanning
the same kind of the images.

To use the Save Scanning Settings command:
1. Click the Files menu and then select “Save Scanning Settings” option.

2. When “Save Settings” dialog box appears on the screen, enter the desired
folder direction and file name and then click the Save button to save.

DASVNScanWizardlS USB\ScanWizard [S\bin} =

e
UST File (*.ust)

3. When done, the Save Scanning Settings dialog box will be closed and you
will be directed back to the window of the main control panel.
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Load Scanning Settings

This command lets you load and use image settings that you have saved earlier,
such as resolutions, color modes, saturation and brightness, helping you to save
time on doing tedious and repetitious settings and improving work efficiency.

To use the Load Scanning Settings command:

1. Click the Files menu and then select “Load Scanning Settings” option.

2. When “Load Settings” dialog box appears on the screen, explore folders
to find out the file you want to use; then, click the Open button to load the

selected file.

DASVNScanWizardLS_USB\ScanWizard_LSWhin v ]

The selected file —

UST File (*.ust)

3. The settings of the selected file will apply to the preview image in the

preview area immediately.

MICROTER

The original image

MICROTER

The image after being applied with
selected file settings
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Restore the Default Settings

This command cancels the current settings used for the scanned image and
retrieve the default values of factory settings.

When this command is selected, a window appears on the screen to remind you
that values of current settings will be restored back to default setting values.
Click the OK button to carry out the action.

Do you wnat to restore scanning
settings to the default settings??

The Scanner Menu

Scanner
Scanner Info

Scanner Info

This command provides information about your current scanner. When you
choose this command, a dialog box appears showing the scanner name, the
scanner serial number, the driver version and the total scanning times.

Scanner's Name : ObjectScan
Serial Number : A123456789
Drivers : v1.04

Total Scanning Times : 58
First Scan : 20157420
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The Window Menu

Window
Preview Window

Tools
Advanced Tools

The Window menu lets you open or close Preview Window, Tools Window and
AdvancedTools Window in ScanWizard LS (USB) software.

e Preview Window: The Preview Window contains a preliminary image
scanned by your scanner.

e Tools Window: In the Tools Window, you can set up basic settings about
your scan job, such as resolutions and color modes.

e AdvancedTools Window: In the Advanced Tools Window, ScanWizard LS
(USB) offers you advanced imaging settings to practice, such as color level,
contrast, saturation and calibration, which are designed for the professional
users in order to satisfy with their specific demands. If you like to restore
the values of settings back to default values, please use “Restore the Default
Settings” in the Files menu.

Open a Window

1.  Use the mouse to click the Window menu and select one of three windows
you like to open (for example, Preview Window).

2. A check mark (v) will appear in front of the window which is selected. Also,
the selected window will appear on the screen.

Preview Window
Files Scanner Window About

T o andTools
Tools o) ) D cl Window are

selected and
eein therefore are
£30lutions .

rharked wih
P check marks

Color (24 hits) ~ MMICROTEK

Advanced Tools

Scan Type
Scanning Area

Preview image

appears in the

. preview area
Tools Window
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Tools Window

Resolutions
H00 DPI -

Color Modes

Color (24 bits) -

Scan Type
S ing Area
Full Scanning Area ~

e Resolutions: Select a desired resolution for outputting the image from a
drop-down menu. The options are 300, 400, 600, 800 and 1600 dpi.

e  Color Modes: Select a desired image output type from a drop-down menu:
— Select Color (24 bits) to scan the image in color
— Select Gray (8 bits) to scan the image in gray

e ScanType: Select a desired image input type from a drop-down menu. The
option is Reflective orTransparent. This option can be selected only when
the connected scanner supports.

e  Close button (X): Click to close the Tools Window.
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Advanced Tools Window

Level Adjustments

Black Levels

Under the Advanced Tools Window, there are four sub-menus which you can use
for coloring settings for scanned images. To open and extend each sub-menu,
just use the mouse to click it; then, you can start to change settings on each
sub-menu. All changes you made will be applied to and shown on the preview
image immediately.

Level Adjustments

e Gamma: Drag the slider left or right to
adjust Gamma values of images.

e  Black/White Levels: Drag the slider left or

right to adjust the dark or light levels of
images. Brighiness/Contrazt/Satnration

Brightmess

Brightness/Contrast/Saturation

e Brightness: Drag the slider left or right
to adjust brightness values of images;
therefore, you can change the lightness of
images.

e Contrast: Drag the slider left or right to
enhance the contrast of images; thus, you
can approve the stereoscopy of images.

e  Saturation: Drag the slider left or right to
increase or decrease the color intensity of |
images.
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Calibration Settings

_umwm&nhm-.uuﬁﬂ

This sub-menu lets you choose which type of
calibrations you like to perform before each
scanning.

Calibration Setlings

e Smart mode: When this mode is checked,
the ScanWizard LS (USB) will memorize
the calibration values generated by ® Smart
different scanning settings. These
memorized settings can be used later
when a scan job with a same value of
scanning settings is performed again.
This mode eliminates calibration time and
therefore enhances the scanning speed
when you often scan materials sharing
same scanning settings.

@ Typical

e Typical mode: If this option is selected,
the ScanWizard LS (USB) calibrates your
scanner before performing a scan job if
the scanning settings are changed. ltis
the default setting of the system.

Im ttin o
age Se gs mwﬂbﬂ‘mmmﬂ

This sub-menu lets you choose the path for
the CMS Profile.

The default setting is ObjectScan1600.icm.

Color Matching

Select CMS Profile Path
\ProfilesYObectScan.1em

Applied
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The About Menu

About

User's Manual

Microtek's Website
About ScanWizard LS

The About menu lets you access the user's manual for ScanWizard LS (USB),
and gives you related information about the ScanWizard LS (USB) scanning
software and its supported website.

User's Manual

When this option is selected, a folder will appear on the screen. In the folder,
you can find user's manuals related to supported scanner models and relevant
language versions. Please select one which is fit to your demand.
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Maintenance

After usage for a period of time, the parts inside your scanner, such as the

light source, may become worn out, and a problem such as insufficient light
supply may occur. In this cases, contact your local dealers or wholesales for the
maintenance services.

Note: Your scanner need a professional to perform the required service or
maintenance. Do not attend to fix or perform the maintenance by yourself, or it
may cause dangers to you or the scanner.
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Appendix

Troubleshooting

The LEDs on the front-left panel of the scanner indicate the status of the
scanner.

‘ Q All On -The scanner is found and

ready to scan \
. Q Green Flashing - Scanning
Q Q All Off - Scanner is off

LED indicators

First, make sure that you have followed steps as described in the “Initial Setup”
section of this document. Then if your problem is listed here, try the suggested
solution.

1. No light comes on when the scanner is turned on.

Make sure your scanner is connected to your computer and plugged into a
power source.

2. The Add/Remove Hardware Wizard appears on your screen.

Click the “Cancel” button and close the ScanWizard LS (USB) scanning
software. Disconnect the Hi-Speed USB cable from your computer, and
refer to the installation instructions in this document.

3. When trying to scan, an error message appears on your screen that reads,
“Can’t Find Scanners”

Make sure your scanner is unlocked (see “Unlocking the Scanner” in the
“Initial Setup” section).

Make sure your scanner is connected to your computer and plugged in to a
power source (see “Connecting the Scanner” in the “Initial Setup” section).

Uninstall and reinstall the ScanWizard LS (USB) software.

4. After clicking “Scan,” a blank screen appears.
Uninstall and reinstall the ScanWizard LS (USB) software.
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Specifications
Model Name

Model Number

Image Sensor

Light Source

Scanning Modes

Color Depth
Resolution
Scanning Area
Scanning Speed
Interface

Dimensions (L x W x H)

Weight
Voltage

Environment

Warranty

Important

ObjectScan 1600
MRS-1600A30S

CCcD

LED (Light Emitting Diode)

Color, grayscale, and black-and-white in a single
scanning pass
24-bit color, 8-bit grayscale

48-bit (Input); 24-bit (Output)
1600 dpi

12“ x 16.7” (305 mm x 424 mm)
12 sec @ 400 dpi, A3 color
Hi-Speed USB (USB 2.0)

29.5" x 18.5" x 14.8"
(750 mm x 470 mm x 376 mm)
(Foot stands are not included)

103 Ibs. (47 kg)

AC 100V to 240V, 47-63 Hz
1.5A Max (Input)

Operating temperature: 41° to 104°F (5° to 40°C)
Relative humidity: 20% to 85%

Machine: 100,000 scans @ 400 dpi, A3 size
or 1 year for normal use

Please never attempt to open or service the machine by yourself; or, this will void your

warranty.

Specifications, software bundles, and accessories are subject to change without notice.
Not responsible for typographic errors.
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